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The PPCUG Holiday Party & Elections. The food, the crowd, raffle drawings and a
winner selecting his prize at the December General Monthly Meeting.

About PPCUG
General Meetings
Second Monday of the month at the
Lawrenceville Library.
Route 1 and Darrah Lane.
7:00-7:45 PM: Social Time / Tech Corner
7:45 PM: Meeting Comes to Order
8 PM: Featured Presentation
For information about upcoing meetings or
joining PPCUG call 908-218-0778 to leave a
message.

Board Meetings
Second Monday of the Month after the close
of the General Meeting.
Board meetings are open to All.

Board Members
President:
Paul Kurivchack ........... 908-218-0778
Vice-President:
Tom Carman ................. TBD
Secretary:
Don Arrowsmith ........... TBD
Treasurer:
Tom Canavan ............... 732-422-9055
Members-At-Large:
Jon Abolins .................. 609-883-8126
Vic Laurie ..................... 609-924-1220
Kim Goldenberg ........... 609-671-9188
Sol Libes ...................... 609-520-9024

Chairpersons
Disk Library:
Tom Canavan ............... 732-422-9055
Hospitality:
Bill Hawryluk ................ 609-655-0923
Member Records:
Paul Kurivchack ........... 908-218-0778
Newsletter Editor:
Paul Kurivchack ........... 908-218-0778
Program Coordinator:
Sol Libes ...................... 609-520-9024
Web Master:
Jon Abolins .................. 609-883-8126

Coming Events
February 5, 2001 - Upgrading your PC
Tom Canavan & Paul Kurivchack will show you the inner workings of your PC
and how to do simple upgrades from memory to hard drives.

March 12, 2001 - Broadband Cable Internet Services
Learn about Cable Modems and the services provides by Comcast@Home.

Presidents Message
by Paul Kurivchack

It’s Y2.001K! Did you ever think we’d get through 2000 after all the
worry of last December and be thinking of starting another new year?
Well we did make it through without a scratch. Hopefully 2001, the
Space Odyssey year will bring us a continued growing economy, a slowing of the
DOT.COM deaths, new innovative personal computing products, and a wider distribution of broadband internet connections so we can all surf at light speeds or at least
something faster than 56K. Hopefully we will be covering the Broadband issue in March
with Comcast@Home and later in the year some more interesting topics. I know Sol is
already thinking about future meetings.
Y2.001K is looking brighter for the Princeton PC Users Group. After five lonely
years without a Vice President, Tom Carman graciously stepped in to take the VP post.
Tom will be a great addition to our board and I look forward to hearing his ideas in
helping the group move forward in 2001.
The hunt is still on for a new LCD projector with my continued research of the
various models available and that it will be purchased soon.
Dues are due for 2001. Please be sure to fill out a renewal form for Tom Canavan
even if you have mailed in your money. This ensures that we have a current e-mail and
postal mailing address for each of our members.
The Linux SIG is still looking for meeting space. If you have any ideas or know
someone, please take the ball and run with it, Jon will need the space soon if he wants
to continue the SIG. In addition, Caldera Systems Inc., was very generous and provided our group a good quantity of Linux OL2.3 and the Linux Technical Preview software. Jon Abolins will be handing out the copies at his next SIG meeting.
Lastly, I hope that everyone enjoyed the food and prizes at the holiday party. Thanks
to Microsoft’s MindShare user group support organization for the software and shirts. It
is always great to go home with a present.
Have a Happy New Year and I look forward to seeing you all on the 8th.

Web Site
http://www.ppcug-nj.org

Annual Dues Rates
Normal dues rate is $30 per year.
New Members Only: after February, the
rate is $2.50 per month times the number of
months remaining in the year.

Dues are Due for 2001
The board has approved
the increase of the
yearly dues to $30.00
for new and renewing
members.

PublishedMonthly by:Princeton PC Users Group
PO Box 291Rocky Hill, NJ 08553©
Copyright 2000 December 2001 Vol. 17 No. 1
The reprinting of original material appearing in this
newsletter in any other publication must credit the
Princeton PC Users Group Newsletter and/or the
Princeton PC Users Group and any authors
shown. The editor and the Princeton PC Users
Group assume no responsibility or liability for
damages arising from the publication or nonpublication of any article in this newsletter.
Opinions expressed in these articles are not
necessarily those of the members of the Princeton
PC Users Group.
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Windows Tips: Scrap That File
By: Vic Laurie - PPCUG
Because they pose one of the most likely, as well as potentially most dangerous, problems that a typical user may encounter
when using e-mail, I am going to enlarge the discussion of viruses in e-mail attachments that I began in the April PPCUG newsletter, http://www.ppcug-nj.org/newsltrs/apr2000.pdf. (For convenience, I am going to use the term virus to include worms and
Trojan horses although sticklers might insist on a distinction.)
In particular, I want to discuss the type of attachments that are
exemplified in two recent widespread virus outbreaks, I Love
You and Life Stages. The first makes use of a vbs file while the
latter uses an obscure type known as a scrap or shs file. Both of
these file types have perfectly legitimate applications and the
insidiousness of viruses that use them is the difficulty that both
users and anti-virus software have in distinguishing dangerous
files of these types from those that are harmless. Further, scrap
files can easily masquerade as something entirely different, making detection even more difficult. Because many users are unfamiliar with these file types, let us first briefly review their normal function.

Script Files
Windows contains a very useful ability to write and use small
script files to carry out a multitude of utilitarian tasks. Web pages also make use of them. The software for this is part of Windows Accessories and is called Windows Scripting Host (WSH).
It provides for scripts to be written in several simple programming languages including VBScript (files with extension .vbs)
and JScript (files with extension .js.) Composite programs using
several types of script can be denoted with the extension .wsh.
Scripts are easy to write and can be quite powerful. (Old-timers
will be reminded of DOS batch files; scripts are much more versatile, however.) For further information go to
http://msdn.microsoft.com/scripting/
http://wsh.glazier.co.nz/default.asp
http://www.zdnet.com/pcmag/stories/solutions/
0,8224,2505166,00.html
http://www.winmag.com/fixes/2000/0901.htm

Scrap Files
A little-known type of file used in a special form of Object
Linking and Embedding (OLE) is the shell scrap object or, as it is
more usually called, scrap file. It has the (normally hidden) extension .shs. (OLE is probably unfamiliar to many readers but
basically it is the ability of certain programs to embed objects
from one program into a different program or to interchange
data between different programs. For example, part of an Excel
spreadsheet can be embedded in a Word document.) Scrap files
are an executable format and can be used to wrap or contain
executable files. See the Microsoft Knowledge Base article at
http://support.microsoft.com/support/kb/articles/Q138/2/75.asp
for further information. Also, there is a detailed article at http:/
/www.pc-help.org/security/scrap.htm, which I highly recommend.
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How Virus Writers Use These Files

Unfortunately, virus writers have taken advantage of both
scripts and scraps to produce harmful files which are attached to
e-mail messages. The ease of writing scripts means that many
small variations on the same virus theme can be produced. Scrap
files can be used to package and disguise an unlimited variety of
harmful executables. Because small changes to the same basic
virus can be made continually, there is no way for the database
of virus definitions used by anti-virus software to keep up. The
anti-virus software companies do try with certain heuristic methods against these and other polymorphic viruses but there will
always be new variations. Hence, relying on anti-virus software
alone is not sufficient and additional security steps should be
taken.

Protective Measures
It is essential that users make the change in settings described
in the December PPCUG article on file extensions (shttp://
www.ppcug-nj.org/newsltrs/dec00.pdf) so that a .vbs file will be
recognized. A virus writer might name a file somefile.txt.vbs, for
example. If extensions are hidden (the Windows default setting) the file will show as somefile.txt, possibly leading a user to
believe the file is a harmless text file. Even worse is the especially sneaky aspect of scrap files provided by the Windows default setting, which always hides the extension .shs even if you
do change the Show All Files sSetting. Thus a file whose real
name is somefile.txt.shs will always appear as somefile.txt, laying
a trap for the unwary. To see the .shs extension, the Registry
must be edited. After first backing up, use REGEDIT or other
Registry editor to delete the Registry entry
HKEY_CLASSES_ROOT\ShellScrap\NeverShowExt.
(Those who regard the Registry as a Twilight Zone never to be
entered may wish to disable Scrap files. See below)
Having made sure that extensions are shown, an e-mail recipient should next follow these three rules:
1. Never open or double-click an attachment unless absolutely sure what it is.
2. Never open or double-click an attachment unless absolutely sure what it is.
3. Never open or double-click an attachment unless absolutely sure what it is.
Yes, I know, that sort of repetition is corny, but being careless
about opening attachments is the major cause of trouble with email viruses. Countless numbers of people clicked on files from
complete strangers saying, “I love you.” It may be tedious to
check out each and every attachment but doing so will obviate
a lot of possible problems.
Also, the security measures for configuring Internet Explorer
and Outlook Express discussed in http://www.ppcug-nj.org/newsltrs/apr2000.pdf should be put in place by those who use this
software. This will place e-mail scripts into a restricted security
zone.
If you never use .vbs or other script files (I find them very
useful but they are not for everybody) and are prepared for error

http://www.ppcug-nj.org
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messages from some Web pages, remove the Windows Scripting
Host. A discussion of the pros and cons of doing this is at http:/
/www.zdnet.com/zdhelp/stories/main/0,5594,2573079,00.html.
Then the system will not be able to run .vbs files (or .js or .whs
or some others). Windows 9X users (but apparently not Windows Me users who can use the alternate procedure given below) can go to Control
Panel|Add/Remove
Programs|Windows Setup. Select Accessories (Fig. 1). Click
Details and scroll to Windows Scripting Host and remove the checkmark. (Fig. 2) Click OK.

Figure 1

A cruder but faster way to disable scripting is to go to the
Windows folder and simply rename or delete the file wscript.exe
and in \Windows\Command\ rename or delete the file
cscript.exe. This still leaves references to scripting in the Registry; they do no harm but tidy people may want to use the uninstallation procedure.
If you wish to retain Windows Scripting Host and the capacity to use scripts, one safety measure is to change the default
action from Open to Edit. An inadvertent double-click will then
merely open the file in Notepad rather than running it. Windows 9X users can go to Control Panel, open the View menu,
Folder Options|File Types, scroll to VBScript Script File (there
will be two entries, one for vbs and one for vbe), (Figure 3) (Windows Me users will find an icon for Folder Options in Control
Panel.) Click the Edit button and change the default action
from Open to Edit, (Figure 4). Do the same for other script types
(js, jse, wsf, wsh). Incidentally, since script files are in text, those
with even a small amount of familiarity with script language
can tell what kinds of things the script might be doing.

Figure 3

Figure 2

Windows Tips continued on page 5
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support vbs files although it does support vbe. The list of supported
applications
given
in
Preferences|Navigator|Applications can be edited to remove
any of the Netscape supported scripting functions that the user
may choose. Note that lack of Netscape support does not preclude dangers from opening downloaded files whose file type is
supported by Windows. It only means that Netscape cannot automatically open such files.

Figure 4

Other Potentially Dangerous Files
There are, of course, many other file types that virus writers
can use for malicious purposes as e-mail attachments. It is impossible to mention them all in our limited space but a list of
potentially unsafe file types can be found at
http://www.winmag.com/columns/powertools/filetypes.htm.
Common sense is the best general defense; making sure you can
read extensions and following rules 1-3 mentioned above will
keep you out of a lot of potential trouble.

Keep Updated

Yet, another measure is to install the free utility “Watchdog”
from Winmag that is available at http://www.winmag.com/fixes/watchdog/default.htm. Trying to open a script file will then
bring up a window warning you of possible dangerous actions.
This can get tiresome if you use many legitimate scripts but for
those who only occasionally use scripts it provides a useful layer
of safety. Another useful freeware program aimed specifically at
Outlook users can be found at http://www.zdnet.com/zdhelp/stories/main/0,5594,2595248,00.html.
Those who do not mind the possibility of losing certain types
of functionality in Microsoft Office or other applications may
wish to disable Scrap files altogether. Go to Control Panel, open
the View menu, Folder Options|File Types, scroll to Scrap
Object, highlight it and click “Remove.” (Windows Me users
will find an icon for Folder Options in Control Panel.) Or go to
the folder \Windows\System\ and delete or rename the file
shscrap.dll. Keep in mind that the potential danger from Scrap
files is from the executables that can be wrapped in them, not
from the Scrap file per se. For example, The Life Stages worm
uses a scrap file to wrap a vbs program. The article mentioned
above at http://www.pc-help.org/security/scrap.htm has many
details.

Be sure to do frequent updates of your anti-virus definitions.
Also, there has been a steady (some would say never-ending)
stream of security patches. Be sure to apply any that seem relevant to your system. See http://www.ppcug-nj.org/articles/
vic_laurie/lookback.html for how to keep up. Microsoft has been
trying to patch up Outlook, for example, to deal with some of
these e-mail problems. See http://www.microsoft.com/technet/
security/virus.asp for the latest security bulletins. Netscape users can go to http://home.netscape.com/security/notes/
index.html.

Acknowledgement
My thanks go to Joel May for comments on the use of scripts
in Web pages and to Sol Libes for filling me in on aspects of
Windows Me.

Netscape 4.7 users can go to the Edit menu and open
Preferences|Navigator|Applications. Scroll down the list
“Description” to Scrap Object. Click “Remove”. This removes
Scrap file support from the Internet functions. Also you can go
to Preferences|Advanced and remove the check by “Enable
JavaScript for Mail and News”. Note that JavaScript and Jscript
are similar but not identical, being part of the Netscape-Microsoft dichotomy. Also, as far as I know, Netscape 4.7 does not
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Minutes for the General Meeting
December 11, 2000
By: Ed Weiss
At 08:07 PM, Paul opened the meeting, the first item on the
agenda was the election of the new officers. Unlike the situation in Florida, we did NOT have any recounts, nor any law
suits over the final numbers. And the winners are:
Paul Kurivchack - President,
Tom Carman - Vice President,
Don Arrowsmith - Secretary,
Tom Canavan - Treasurer,
John Abolins, Kim Goldenberg and Sol Libes - Members At
Large
Congratulations to the new members, and those continuing
to serve. Thanks to those leaving their board positions.
The next item was a listing of the schedule of programs. In
January, Microsoft will be giving a presentation. In February,
our own Paul and Tom will due a presentation on building your
PC. (NOTE: the February meeting will be on the first Monday
of the month.) And in March, we have Comcast lined up to
present to the group.

Also of note, is that there will be NO board meeting this
month.
The Linux SIG is still looking for a meeting place, and anyone with any ideas on places where the SIG could meet should
contact John Abolins or Paul Kurivchack.
With all the business activities out of the way, the Christmas
party began, and as the members sampled all the food and drink,
there were many topics being discussed in different areas of the
room. About 9:15 PM, Paul gathered in the badges from the
remaining attendees, and the drawings for the door prizes began. Congratulations to all the winners of the door prizes. At
9:25 PM the meeting and party were closed. Thanks to all the
members who stayed to help clean up the room, and put away
the chairs. Happy Holidays to all..
Final minutes by Ed Weiss

Sites to Fight Scams

General Monthly Meeting
Schedule for 2001

By: J.D. Abolins - PPCUG
Con jobs have be with us from time immemorial. Con artist
move to whever opportunities present themselves. They are fast
to explore ways to scam people using new technologies, such as
the telephone or the Internet. Here are some helps to prevent
being defrauded.
U.S. Federal Trade Commission

January 8, 2001 – Monday
February 5, 2001 – Monday* - First Monday
March 12, 2001 – Monday
April 9, 2001 – Monday

- “Dot Con” - Top 10 Online Scams:
http://www.ftc.gov/bcp/conline/edcams/dotcon/index.html

May 14, 2001 – Monday

- International Telephone Number Scams:
http://www.ftc.gov/bcp/conline/pubs/tmarkg/intlphon.htm

June 11, 2001 – Monday

National Fraud Information Center

July 9, 2001 – Monday

- http://www.fraud.com/

August 13, 2001 – Monday

New Jersey Division of Consumer Affairs

September 10, 2001 – Monday

- http://www.state.nj.us/lps/ca/home.htm

October 15, 2001 – Monday* - Third Monday

ScamBusters.org

November 12, 2001 – Monday

- http://www.scambusters.com/

December 10, 2001 – Monday
Note: All dates are for the second Monday of the Month
except for February (Library Closed) and October (Columbus Day) falling on the second Mondays.
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PPCUG Member E-mail Directory
Name
Last
Abolins
Adler
Arrowsmith
Axelrod
Best
Bolge
Canavan
Caris
Carman
Chilton
Cohen
Colucci
Crossley
Davis
Dinkins-Belton
Dodge
Donovan
Duggins
Edge, Jr.
Einthoven
Ewer
Farah
Foulkes
Gibson
Goldberg
Goldenberg
Goodkin
Griegel
Gunther
Hardy
Hawryluk
Henry
Hirsh
Holly
Johnson
Juelch
Kahan
Kamat
Kerslake
Kleinerman
Kleinerman
Konvalinka
Koosman
Krisak
Kurivchack

First

E-Mail
Address

Name
Last

First

E-Mail
Address

John D.
Seymour
Donald L.
Albert
John J.
Eleanor
Thomas
Paul D.
Thomas
Neal W.
Jon
Frank E.
Helen M.
Perry J.
Joyce
William B.
Kyle R.
Marsha
Lewis A.
Bella
Tim
Avi
Frank
Dawson H.
Edwin M.
Kim
Jerry
Wayne B.
Bruce W.
Wayne
Bill
Chuck
Donald J.
Lois
Florence
H. Karl
Maurice
Prakash
David
Irma
Milton
John W.
Milton
Bill
Paul

jda-ir@njcc.com
syadler@aol.com
donald.arrowsmith@bigfoot.com
aaxelrod@erols.com
jjbest57@alum.mit.edu
embolge@jersey.net
tcanavan1@aol.com
pdcaris@yahoo.com
tom_carman@compuserve.com
chilforce@aol.com
jon@pluto.njcc.com
DasWeb1@aol.com
CrossleyHM@aol.com
perrydavis@compuserve.com
Joyce8NJ@aol.com
b-mdodge@juno.com
stoneflykd@aol.com
msd@gfdl.gov
lewis@edgeassoc.com
einthoven@mail.eclipse.net
tjewer@worldnet.att.net
avifarah@netzero.net
ffoulkes1@aol.com
wkgbill@earthlink.net
EdGoldberg@home.com
kim_goldenberg@bigfoot.com
goddkin@erols.com
wgriegel@ix.netcom.com
bg1509@hotmail.com
wayne97wh@aol.com
hawr@compuserve.com
chenry@eclipse.net
djhirsh@earthlink.net
lois@audet.com
kredit@erols.com
karljnj@nerc.com
mkahan@juno.com
mandpt92@hotmail.com
dongsung@juno.com
rafiki@iopener.net
kukumafi@Juno.com
jkonvalinka@msn.com
miltonk2@aol.com
BobKrisak@worldnet.att.net
kurivchack_p@compuserve.com

Landis
Laurie
Lazar
Lewis
Libes
Markward
Maruska
Metzler
Middleton
Miller
Mintz
Montani
Mooney
Oldenburg
Olson
Papier, Jr.
Phadke
Pitcher
Polignano
Pratt
Reichart
Rothstein
Rouse
Rutzky
Sked
Steinman
Stockwell
Suber
Sweeton
Tayyabkhan
Tenner
Treadwell
Walthall
Weinberg
Weiss III
Williams
Willis
Willis
Wolff
Shah

Houston E.
Vic
Joseph
Lloyd N.
Sol
Margaret
John
Joseph
Frank
Douglas E.
Herman
Linda
William P.
Thomas A.
Gaylord
Philip B.
Laxman G.
Barbara
Vince
Zeblon H.
Richard
Rick
H. Ronald
Mark M.
Bill
Arthur M.
Hunt
Michael J.
Andrew
Mike
Edward
Isaac
Ronald K.
Robert
Edward A.
Ken
Lloyd
Robert S.
William V.
Sonal

judge@alumni.princeton.edu
hampsi@bigfoot.com
joelazar@nerc.com
Budnorth@juno.com
sol@libes.com
mteragram@aol.com
maruska1@juno.com
76116.3117@compuserve.com
ftmprob@nerc.com
D.N.Miller@worldnet.att.net
hmintz4@aol.com
l.montani@worldnet.att.net
wmo8350722@aol.com
oldenburg-ta@worldnet.att.net
go@electrim.com
papierp@superlink.net
layogph@aol.com
bpitcher@ets.org
vincepo@worldnet.att.net
zpratt@aol.com
reichart@pluto.njcc.com
fnroth@aosi.com
DrRonRouse@aol.com
marky@infi.net
billsked@aol.com
amsteinman@aol.com
huntstock@aol.com
mpsuber@juno.com
asweeton@roper.com
tayyabkhan@aol.com
tenner@clarity.princeton.edu
itreadwell@msn.com
DKDM83A@prodigy.com
bweinb@worldnet.att.net
eweiss@nerc.com
krw1948@worldnet.att.net
lwillis1@prodigy.net
Robert4269@aol.com
wvwa@bellatlantic.net
sonals@microsoft.com

(Last Update: December 4, 2000)
Send Updates to kurivchack_p@compuserve.com for inclusion in this listing.

Consultants Corner

Meyda Online

Meyda means Information
J.D. Abolins
Pro Bono Educational Services
Specialties: Information Security, Privacy
Issues, and Web Publishing
http://www.meydabbs.com
E-mail: jda-ir@njcc.com

Consultants Corner

You can advertise your consulting business for $25 per year in addition to your normal
membership fee. The text space is your or your companys name plus five lines.

January 2001

http://www.ppcug-nj.org

About Weird Bytes -- Usage Conditions
Weird Bytes comic strips may be used for free by computer
users groups and other not-for-profit groups. The comic strips
should include the copyright notice and the Weird Bytes Web
address. As a favor, please send an email indicating the users
group or publication.
Personal use as desktop wallpaper images and such are also
free of charges.
Should you want to change the text or pictures in the comic
strips, please indicate that you’ve modified the original comic
strip. If you find a typos that needs to be corrected, go ahead,
correct it. Please let me know of the typo. I’ll go to a mirror
and reprimand the quality control person I see in the mirror.
You may translate the text in the comic strips into other
languages so your readers can understand the comic strips. If
you do this, please send me a copy of the translation for my
archives.
For commercial use of the images, please contact Weird Bytes.
Thank you.
J.D. Aboilins ---- weirdbytes@meydabbs.com
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Directions To Our Meeting:
The Lawrence Library is at the corner of Business Route 1 South and Darrah Lane.
From Princeton and North: Take US Route 1 South, past the Quaker Bridge / Mercer Shopping Centers. Continue on approximately 1 3/4 mile past I295 to the Route 1 split, stay to the right to Business Route 1(Brunswick Pike). First traffic light is Darrah
Lane. Library is on right side. Park in lot towards Route 1 and to the rear. Enter Library at main enterance in front. Meeting rooms
A & B are located through glass door on Route 1 side of building.
From Trenton and South: Take I295 North to US Route 1 South. Library is approximately 1 3/4 miles south of I295. Continue
south to Business Route 1(Brunswick Pike). First traffic light is Darrah Lane. Library is on right side. Park in lot towards Route 1 and
to the rear. Enter Library at main enterance in front. Meeting rooms A & B are located through glass door on Route 1 side of
building.
For additional information visit http://www.ppcug-nj.org

Microsoft Windows ME
January 8, 2001
Lawrence Library

P.O Box 291
Rocky Hill, NJ 08553

Princeton PC Users Group

